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Introduction

It is very easy to maintain gradesheets using Microsoft Excel 2001 software. This is a
step-by-step procedure to follow to set up a simple gradesheet. As you become more
familiar with the program you may want to expand Excel’s duties to create a more
elaborate gradesheet.

Obtaining Your Class List

Because you don’t want to have to type in all your students’ names and social security
numbers yourself, the first step in creating any gradesheet is to have your class list
downloaded from MAUI, Foothill’s easy-to-use VAX interface. If you don’t already
have an account, the easiest way to obtain this list is to ask me (Kathy), or your division
secretary to download it for you. It only takes a few minutes and all you need to supply
is a ZIP disk for the information to go onto.

Once the class list has been downloaded, the icon for it will look like
the picture to the left. This is a generic document icon, which is not
affiliated with any particular software program, so if you double-click
on it, the document will open up in Simple Text, not Excel. (This is
bad.) To work around this, here are the steps you need to do:

1. Open Excel.

2. From the File menu, choose Open.

3. Maneuver through the dialog box until you find your class list document,
select it and click on the Open button. For this exercise, open up the Grades
99 document.

4. The Text Import Wizard will open up. There are several options here, but for
our purposes, all you need to do is to click on the Finish button.
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5. Your document will now open up in Excel and look very much like this: As
you can see, there are six columns of information, not all of which we need to
keep.

Excel Workbooks

Using Excel 2001, your work can be gathered into a workbook. The workbook can
contain several pages, both spreadsheets and charts. In our case, we will have an Excel
workbook that will consist of a separate page for each of your classes for the quarter.
You don’t need to have separate documents for each class.

When you first open up your class list that was downloaded from MAUI, it is not
formatted as an Excel Workbook. Instead it is in Text format and only has one sheet. In
order to create as many sheets as you have classes, simply go up to the Insert menu and
drag down to Worksheet. Repeat doing this as many times as needed so that you have a
separate sheet for each class you teach. If you look down at the bottom left edge you
will see the tabs to other pages. We’ll move data onto those sheets shortly.

Now is a good time to save your document. Choose Save from the File menu. You will
notice that the file type is Text. That is the default for MAUI documents. Change the file
type to Microsoft Excel Workbook (versions 98/98 or 2000/2001 are both OK) before
saving. If you don’t change the file type, you will lose all but one of the worksheets.
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Formatting the Data

There are six columns of information on this spreadsheet. All the columns are equally
sized, so some information is cut off, while other cells look nearly empty. It is much
easier to work on a spreadsheet where you can see what you’re working with.

1. Place your cursor on Column Heading A. Click and drag the mouse over to
Column F. All the columns from A through F are highlighted (black). Let go of
the mouse.

2. Move your cursor onto any line between column headings: for example, the
line between Column Heading B and Column Heading C. Your cursor turns
into a solid black, two-headed arrow. Double-click the mouse.

3. This action resizes the columns for a “Best Fit.” You’ll notice that Column A
is now too wide. That’s because the information in cell A2 takes up that
much room to show, and Best Fit resizes to show everything in each cell.

4. Click on Column Heading A. The information in this column is just the
instructor’s name, which you already know, so you can delete it. The column
should already be selected, since you clicked on the column heading. So type
Command-Hyphen, or go to the Edit menu and choose Delete. That
information will vanish and the rest of the columns will move over to the left.

5. You also don’t need the single letter code that is now in Column B, so delete it
in the same manner.

You now have columns A, B, C and D:

A = class ID

B = student social security number

C = student phone number

D = student name
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For now, leave Column A–class ID. If you teach more than one class or section, students
will be grouped by class and the only way you can tell what class the student is enrolled
in is by this column.

We need to format the social security numbers. Several of them have leading zeros (0),
which don’t show. That’s because ordinarily leading zeros are truncated.

1. Click on Column Heading B (the column with social security numbers) to
select the entire column. Then go up to the FORMAT menu and drag down to
Cells….

2. Make sure that you’re in the first window (Number tab). From the Category
list on the left, choose Special.

3. In the box on the right side, choose Social Security Number from the choices,
and click OK.

Format the phone number list using the same procedure as you did for the social security
numbers.

Sorting Data

1. Click anywhere inside the data. From the Data menu, choose Sort…
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2. In the Sort by box, if NAME is not already selected, choose it from the pop-
up list. Make sure that the My list has Header row is selected. Click OK.

3. Look at the data in Column A. You’ll notice that, although the names are in
alphabetical order, the class IDs are all mixed up. So now click anywhere in
the table and choose Sort… again from the Data menu.

4. Select Sort by CLASS_ID and click OK. Now the names are in alpha order
within each class section.

5. Save your work.

Although we did this in two steps, it can be accomplished in only one step. In the Sort
box, first set to Sort by CLASS_ID, Then by NAME before clicking the OK button. I
always get confused by doing more than one sort at a time.

Moving Data onto Separate Worksheets

This is a good time to separate the data onto individual sheets for each class. On this
sample document we have three sections on our list: EDIT 1, EDIT 2 and EDIT 3. At the
bottom of the screen you’ll see three tabs: one for the first sheet, and then two more, for
those worksheets we created earlier. These are individual pages of the workbook. We’ll
name the sheets: EDIT 1, EDIT 2 and EDIT 3, and move the coresponding data onto
each sheet.

My data is on the third sheet. Your data may or may not also be on the third sheet, but
my instructions will describe what to do if you’re set up like me. If your data is on the
first sheet, then you’ll have to adapt somewhat.

1. Double-click on the tab most to the left. When you do, the existing word
(Sheet 2) become highlighted. Simply type in the name for this worksheet of
EDIT 1.

2. Double-click on the middle tab and name this sheet EDIT 2.

3. Double-click on the last tab and rename this sheet EDIT 3.

4. Go to the sheet with all the data (3rd sheet for me) and highlight the rows
headers for students in EDIT 1. Then choose EDIT ➪ Cut. A little dotty-box
will go around the text.

5. Click on the tab you named EDIT 1 (sheet 1 for me) to make that the active
sheet. Place your cursor in cell A5 and choose Edit ➪ Paste.

6. Return to your data and repeat the process for students in EDIT 2.

7. Return to the original data sheet. Although this sheet contains the correct data
(students in EDIT 3), there are now many empty rows between the headers
and the data. Simply highlight the rows that are empty and type
COMMAND-HYPHEN to get rid of the extra rows.

8. Save your work.
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Setting Up the Gradesheet

Now that the classes have been separated onto their own individual worksheets, we
don’t need the CLASS_ID anymore. To delete this column, click on Column Heading A
and type COMMAND-HYPHEN. Now you’ll have more room to see your gradesheet
itself. You can also delete the column with phone numbers if you won’t need them.

Above the list of students I always add a row with the information for a Perfect Student
who gets the total possible points. But right now the row directly above the first student
has heading information, which I want to keep. So we need to insert a row.

1. Highlight the row below where you want the new row. So in this case, click on
the Row 7 heading (or whichever row has your first student in it.)
Then type SHIFT - COMMAND - ✚ to insert a new row. The new
row is highlighted. Before moving along, click on the Italic Icon on the
Formatting Palette to make the entire row italics, which will help set it apart
from real students.

2. In the Name cell of the new row, type Perfect Student.

Adding Column Headings

In the row above the new row we have the existing headings: STUDENT_ID and NAME.
We will also put the headings for things we grade: Quiz 1, Quiz 2, Midterm, Final, etc.
here.

1. In this heading row, click in the cell to the right of NAME and type HW 1. Hit
the TAB key to move right to the next cell in the row and type HW 2. Keep
adding homework headings until you have HW 1—HW 5.

2. In the next cell type HW Total.

3. Skip a cell and add Quiz 1—Quiz 3 and a Quiz Total.

4. Skip a cell and add Midterm, Final and Total Points.

These look pretty bad because the titles take up way too much room. we only need the
cells to be 2-3 characters wide except for the heading row. So what can we do?

5. Highlight the whole heading row by clicking on the row number on the left
edge (Row 6 for me).
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On the Formatting Palette, make sure the Text Alignment segment is open. As
you can see from the image above, there are several choices to orient your
text. Choose the first option (rotate text up).

6. Now the text is vertical instead of horizontal but the cells are still too wide.
Highlight Column Headings C-P (or over to include all columns with data) and
double-click between any two headings to do a quick “Best Fit.”

The columns which were empty will have to be manually resized by dragging
the right cell heading over to the left.

7. Save this document. Close it. Stand up, stretch and take a break.

Calculating Grades

Open up the SMILES 01 grade sheet document, located in the SMILES 01 ➪ 8/28 Excel
folder. It should look very similar to the document you created except that data has
been added. We will be working from this document for the rest of the exercise. You’ll
notice that although homework points and quiz and test scores have been entered, no
totals have been calculated. We’ll do that now.

1. To total up the homework points, click in Cell H7 (Perfect Student HW
Total).

2. Click on the AutoSum icon in the top toolbar (  ) A formula will appear in the
Formula Bar (which is located under the toolbars):  =SUM(C7:G7) and
“marching ants” will appear around the homework totals for the Perfect
Student–indicating what amounts will be added.
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3. This is, in fact, what we want to add, so hit the ENTER key. (Not Return!)

We now want to add the homework totals for each of the students, and there is a
shortcut for doing it:

4. Place your cursor over the bottom right corner of cell H7. It turns into a hollow
box (the autofill box). While holding down the mouse, drag down the column
to the end of rows with data. Then release the mouse. As you drag the mouse,
you are copying the formula (=Sum...) into each cell, so when you are done
dragging, the homework totals are all calculated for all the rows.

5. In the same manner, calculate the Quiz totals.

6. You may have noticed that in addition to copying the formulas, you
also copied the cell formatting, so now all your totals are italicized.
Highlight the HW Totals for all the real students (not Perfect Student),
and click on the I on the Formatting Palette to set these figures back to
normal. Do the same for the Quiz Totals.

Now we need to calculate the total number of points for the entire quarter. This amount
is going to include HW Total, Quiz Total, Midterm and Final. We can’t just do a simple
sum because we need to add together cells that aren’t adjacent to each other. Instead we
will write out our own formula:

7. Click in Cell Q7 and type an equal (=) sign. (All formulas begin with an equal
sign.)

8. Then click on the HW Total cell, type a plus sign (+), click on Quiz Total cell,
type +, click on Midterm cell, type +, click on Final cell.

9. Your formula should read:   = H7 + M7 + O7 + P7. If it does, hit the ENTER
key.

10. You should get the total of 400 in Cell Q7. If you accidentally clicked
anywhere else while entering the formula, you will have added in figures you
don’t want to include. You will need to edit the formula to include only what
you want. Do this editing in the formula bar.

11. Now you can click on Cell Q7 and drag the corner down to get the totals for
all the students. Be sure to save your work!

At this point we could be finished with the grade sheet. You will have to go in and
assign grades based on the point totals calculated by Excel, print it out and you’re done.
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Letter Grades

If you don’t want to have to put in the letter grades yourself, there is another step.

First, let’s make a simple little text message at the bottom of the sheet to state how
many points each grade is worth.

1. Go up to the VIEW menu, drag down to Toolbars, drag to the right and
release on Drawing. The Drawing Toolbar will show up on the left side of
your monitor.

2. In the middle of the toolbar there is the little Textbox icon. Click once
on this icon and then move your cursor up onto the spreadsheet to a
spot underneath the grades.

3. Click the mouse button and drag down and over to the right to make a box.
When you release the mouse button, your cursor is blinking in the box, waiting
for you to type. Type out the following:

4. Once you’ve entered the text, if you find your box is too big you can resize it
by dragging one of the selection boxes on the edges or corners. You can move
the box by dragging it from the edge–not on a selection box.

Creating a Lookup Table

The next step involves making a “Lookup Table.” We will set this up so Excel will
“read” the number of points each student earned, and “look up” the corresponding
grade in a table, and then assign the grade to the student.

1. 1) Scroll over to the right of your gradesheet, to about the T column.

2. 2) In cells T7 through X8, type:
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3. We need to name this table so Excel knows where to look up.
Highlight cells T7 through X8 (the table), go to the INSERT menu, and pull
down to Name—Define.

4. Name these cells TABLE and click on the Add button.

To have Excel automatically assign letter grades:

1. Starting with the Perfect Student, click in Cell R7.

2. We need to insert a formula here, so from the INSERT menu, choose
Function….

3. From the Function category, choose Lookup & Reference. On the right side of
the dialog box, choose LOOKUP. Click OK.

4. A new dialog box appears: Select Arguments. Choose the second option:
Lookup–value, array. Click OK.
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5. Yet another dialog box appears:

6. In the top box it wants to know what value to look up. This is the Total
Points for Perfect Student, so on the worksheet, click on Cell Q7 (value =
400).

7. Click in the bottom box. This is where you indicate where to look up the
answers. Go over to Cell T7 and drag down to Cell X8. Since you’ve defined
this as your table, Excel puts table in this box. (Alternatively, you can type
t a b l e in this box, which might save you some time.) Click OK.

8. The grade A will show up in Cell R7 (the cell we set this function up in). The
formula in the formula bar reads: =LOOKUP(Q7,table).

9. Click that little box in the right corner of Cell R7 and drag it down to fill the
formula for the rest of the students.

Ta Da! The Grades Are Assigned!

Now is a good time to SAVE your work.

PRINT the GRADESHEET
The object of creating an Excel worksheet like this is to be able to turn in your grades. So
now you need to PRINT out the sheet.

If you do a quick Print-Preview from the FILE menu, you’ll see that your grades are going
to print out on two “portrait” sheets of paper. It would look a lot better if you print the
grades out on one “landscape” sheet of paper. These are the steps for printing out the
way you want:

If you’re still in Print Preview, click on the Setup button at the top of the window. If
you’re not in Print Preview, choose Page Setup from the FILE menu.
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Page Setup

PAGE:
Choose Landscape orientation. You can
also set scaling here: click on the Fit to 1
page wide by 1 page tall. When you choose
this option, the document is scaled to fit
on only one sheet. Be careful if you have
lots of data; you may end up with data
too small to read.

MARGINS:
Set your margins in this window. If you
want you can center the table horizontally,
vertically or both.

HEADER/FOOTER:
If you want, place a header or footer on
your page. Choose preformatted options
from the pop-down list in the box above,
or create your own by clicking on the
Custom buttons. The Custom Header box
looks like this. The Custom Footer box
looks just the same. Click where you want
your text to be and type it in.

Incidentally, you can adjust the character
formatting (font, style, etc.) by clicking the
Custom button. Then click on the A icon.
The Font window will open to allow you to
customize your header (or footer).



14

SHEET:
Your spreadsheet will be a lot easier to
read if the gridlines show. In previous
versions of Excel, they printed
automatically, but on my sample document
they didn’t print at first. To print the
gridlines, go to the Sheet window (shown
above) and click so there is an X in the
Gridlines box.

Print Preview

Be sure to click the Print Preview button before actually printing. Sometimes the preview
looks different than what you expected. If so, just return to Page Setup and keep
adjusting until you are satisfied with what you see.

When you are ready to print, click on the Print button or choose Print from the FILE
menu.

Closing Remarks

v Add your data as it becomes available. It is simple to update your gradesheet
if you do it fairly regularly.

v At the end of the quarter, sum up the totals and assign grades. This can then
be turned in to Admissions & Records.

v Your gradesheet can be as simple or as elaborate as you wish. I have seen
gradesheets as simple as only having the data entered and totals summed up.
Then the instructor assigns grades by hand from the point totals.

I have seen other gradesheets that were so elaborate that it took me 30 minutes
to figure out what was going on. There is an instructor that has Excel total up
all the points, drops the lowest quiz score, calculates the final point total and
then looks up and assigns the grade automatically from the table. THEN Excel
figures out a frequency chart so the instructor can tell at a glance how many
students fell into the A range, the B range, etc.


